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PREFACE

Preface

Safety Information

CAUTION!   ALWAYS USE CAUTION WHEN INSTALLING TELEPHONE LINES. READ THE CAUTIONS 
BELOW FOR DETAILS ON SAFETY GUIDELINES TO PREVENT INJURY.

The installation of a MASTERseries unit is to be performed by qualified personnel only.
Never touch uninsulated telephone wires and terminals unless the telephone line has been 
disconnected at the Network Interface (NI) as voltage potentials as high as 300 VAC may be 
present across the transmit and receive pairs.
Only use No. 26 AWG or larger telecommunication line cord, to reduce the risk of fire.
Never install telephone wiring during a lightning storm.
Never install telephone jacks in wet locations unless the jack is specifically designed for wet 
locations.
Refer to the installation section of this manual for a safe and proper installation procedure. All 
wiring external to this equipment should follow the current provision of the National Electrical 
Code.
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Preface
Electrostatic Discharge (ESD) Precautions

Electrostatic Discharge (ESD) Precautions
ESD can damage processors, circuit cards, and other electronic components. Always observe the 
following precautions before installing a system component.

1. Do not remove a component from its protective packaging until ready to install it.
2. Wear a wrist grounding strap and attach it to a metal part of the system unit before handling 

components. If a wrist strap is not available, maintain contact with the system unit throughout 
any procedure requiring ESD protection.

WARNING!   INTEGRATED CIRCUITS (ICS) ARE EXTREMELY SUSCEPTIBLE TO ELECTROSTATIC 
DISCHARGE. UNLESS YOU ARE A QUALIFIED SERVICE TECHNICIAN WHO USES TOOLS AND 
TECHNIQUES THAT CONFORM TO ACCEPTED INDUSTRY PRACTICES, DO NOT HANDLE ICS.

The ESD warning label appears on packages and storage bags that contain 
static-sensitive products and components.



QUICK START GUIDE

MASTERseries Quick Start Guide

In this Guide

Unpacking and Inspection
Installation Environment
2-Slot Chassis Installation
8-Slot Chassis Installation
Local Management - Logging in to the 
FLEXmaster
Connectors
LEDs

NOTE:  Multiple modules, master/slave functionality, and E1 functionality are not supported 
in this release.
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Unpacking and Inspection

WARNING!   OBSERVE PRECAUTIONS FOR HANDLING ELECTROSTATIC DEVICES.

1. Inspect containers for damage during shipment. Report any damage to the freight carrier for 
possible insurance claims.

2. Compare packing list with office records. Report any discrepancies to the office.
3. Open shipping containers, be careful not to damage contents.
4. Inspect contents and report any damage.
5. If equipment must be returned for any reason, carefully repack equipment in the original 

shipping container with original packing materials if possible. 
6. If equipment is to be installed later, replace equipment in original shipping container and store 

in a safe place until ready to install.

Installation Environment
The environment in which you are installing the Adit 600 must meet the following conditions:

Operating temperature range: -40° to 149° F (-40° to 65° C)
Storage temperature range: -40° to 158° F (-40° to 70° C)
Maximum operating altitude: 10,000 ft. (3,048 m)
Minimum operating altitude: 197 ft. (60 m) below sea level
Maximum non-operating altitude: 40,000 ft. (12,192 m)
Relative humidity (non-condensing) range: 0 to 95%
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2-Slot Chassis Installation
The 2-slot chassis has two application module slots and two power supply slots for redundant power. 
Dimensions: 

1.75 in (H) x 19 in (W) x 10.2 in (D). 
Maximum depth of the shelf, including cables, is 12 inches
Rack Mounting: 19 or 23 inch rack

NOTE:  Blank faceplates must be installed on each empty slot to be in compliance with 
product emission standards.

Supported Configurations
The following table indicates the configurations supported by the 2-slot chassis. 

For information about configurations supported by the 8-slot chassis, see 8-Slot Chassis Installation on 
page 20.

Double 
Fan

Triple 
Fan

FM16 
TDM

FM16 
ATM

FM16 
PWE

Total Number 
of Modules

1 1*

1 1*

1 1*

Application
Application

Power Supply
Slot 2 Power Supply

Slot 1

Module Slot 1
Module Slot 2

19"

1.75"

10.2"
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Rack Mount Installation
Mounting brackets for a 19-inch rack are installed on the chassis when shipped. If you want to install 
the chassis in a 23-inch rack, you must purchase 23-inch mounting brackets from Turin Networks.
Installation of the 2-slot chassis is as follows:

1. To install the unit in a 19-inch rack, attach 
the unit with the brackets to the rack using 
the screws provided.

2. To install the unit in a 23-inch rack, remove 
the 19-inch mounting brackets and replace 
them with 23-inch mounting brackets 
purchased from Turin Networks.

3. Ground the unit by attaching ground wire from the 
terminal block to the frame ground. 

WARNING!   THE GROUND TERMINAL ON THE POWER 
BLOCK MUST BE CONNECTED TO THE FRAME GROUND TO 
PREVENT POSSIBLE DAMAGE TO THE EQUIPMENT. 

19-inch Mounting 
Bracket

23-inch Mounting 
Bracket

black green

+   -

black

+   -
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Power Supply Installation and Cabling

DANGER!   POSSIBLE SHOCK HAZARD EXISTS - PLEASE FOLLOW INSTRUCTIONS 
CAREFULLY. ENSURE THAT NO POWER IS PRESENT ON POWER LEADS AND THAT 
THE CHASSIS POWER SWITCH IS OFF WHEN PERFORMING THE PROCEDURES IN 
THIS SECTION.

This section describes the power supplies used in the 2-slot chassis and provides instructions for 
installing and setting up cabling for the power supplies.

+24/-48 VDC Power Supply
FLEXmaster modules are powered by +24/-48 VDC power supplies. The power supplies are 
redundant and load sharing. 

The LED states of the power supply are as follows: 

NOTE: MASTERseries Release 6.0 introduced a 
new 24/-48 VDC power supply that is identified 
by a small white dot on the faceplate. 

DC Configuration Power Supply 
Wattage

Input Power 
Feed(s) Fuse

+24/-48VDC (24 – 65VDC input) 30W dual 3.15A

LED State Description
Power Off DC input missing or failure

Green DC input present
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Power Supply Installation
To install the first power supply:

1. Remove the blank faceplate from power supply slot 2.
2. Slide the power supply halfway into the empty slot, and plug the fan’s power connector into 

the power supply.

3. Slide the power supply the rest of the way into the slot. Press firmly to make full contact 
with the connector at the back of the chassis.

4. Insert and tighten the screws on the front of the power supply.
5. For redundant systems, install a second power supply into power supply slot 1 following 

the same procedure (except for connecting the fan).

Fan Power Connector
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Power Lead Connection
The +24/-48 VDC power entry module provides DC power protection and isolation when the leads 
are properly attached. 

Each input has its own return. The labels of the power entries vary based on what version of the 
chassis you have:

FEED A (IN A/RTN A) operates power supply A
FEED B (IN B/RTN B) operates power supply B

DANGER!   POSSIBLE SHOCK HAZARD EXISTS - PLEASE FOLLOW INSTRUCTIONS 
CAREFULLY. 

ENSURE THAT NO POWER IS PRESENT ON THE POWER LEADS TO BE CONNECTED 
AND THAT THE CHASSIS POWER SWITCH IS OFF.

To connect the power leads:
1. Remove the power terminal block for easier lead attachment by 

prying off the block with a screwdriver.
2. Strip the two wires from the power source so that approximately 

5/16 inch of bare wire is exposed. 16 or 18 AWG insulated 
copper wire is recommended for power connections.

3. Attach leads to the appropriate terminals using the screws on the 
block to secure them. The illustrations on the following page 
show the positioning of the leads.

4. Be sure to attach the ground wire as described in Rack Mount 
Installation on page 8.

5. Ensure that no bare wire shows after the wires are installed.
6. IMPORTANT: Do not connect power yet.

Power Entry Module Alarm Terminal BlockDC Line Input Fuses
(A and B feeds)

Connect 16-18

Wire Securing Screws

Gauge Wire Here
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If You are Using Redundant Power 
Supplies...
Power must be connected to both A and B 
feeds. Attach the leads to the appropriate 
terminals as indicated in the diagram at the 
right. 

If You are Using a Single Power 
Feed with Dual Power Supplies...
If you only power the A feed and are using 
two power supplies, you need to jumper 
between Input A and Input B and also 
between Return A and Return B. Make this 
jumper the same gauge as the feed. Attach the 
leads to the appropriate terminals as 
indicated in the diagram at the right.

Ferrite Bead
A ferrite bead is required on the power cable. Install a ferrite bead (part number 010-0051) on the 
power cable with a loop as shown below. It is recommended that the ground wire be included in the 
ferrite bead.

Earth
Ground

RTN A
Return A

-48VDC

+24VDC
or

-48VDC

+24VDC
or

IN A
Power Entry A

IN B
Power Entry B

red redblack green

+   -

blackred black

+   -

RTN B
Return B

Earth
Ground

RTN A
Return A

-48VDC

+24VDC
or DC Power

Jumpers

IN A
Power Entry A

IN B
Power Entry B

redblack green

+   -

blackred black

+   -

RTN B
Return B

black
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Power Cable Routing
To meet emissions standards, the power cable must be routed away from all other cables connected 
to the chassis. These include the alarm, Ethernet, NMS, T1/E1, and V.35 cables. As an example, 
you might route the power cable as shown below.
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Alarm Contacts
The alarm terminals are located next to the power entry module. If you use the alarm contact feature, 
attach leads to the appropriate terminal using the screws on the terminal block to secure them. The alarm 
terminal block can be removed for easier lead attachment. Plug the terminal block back into the alarm 
module when finished.
The following table describes the alarm terminal contacts. 

Ferrite Bead
Install a ferrite bead (part number 010-0051) with a loop on the alarm leads as shown below.

Contact Alarm Description
Major Alarm N.C. 

COM
N.O. 

Normally Closed
Common
Normally Open

Minor Alarm N.C. 
COM
N.O. 

Normally Closed
Common
Normally Open
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Alarm Lead Routing
To meet emissions standards, the alarm leads must be routed away from all other cables connected 
to the chassis. These include the power, Ethernet, NMS, T1/E1, and V.35 cables. As an example, 
you might route the alarm leads as shown below.

Applying Power 

DANGER!   POSSIBLE SHOCK HAZARD EXISTS - PLEASE FOLLOW INSTRUCTIONS 
CAREFULLY.

After all procedures in Power Supply Installation and Cabling on page 9 and (optionally) Alarm 
Contacts on page 14 have been completed, apply power as follows:

1. If you have not yet done so, plug the power terminal block into the power entry panel. 
2. Apply power to the chassis by turning on the power switch.

A green light should appear on the power LED on the front of the power supply.
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Modules

WARNING!   STATIC PROTECTION IS REQUIRED DURING INSTALLATION. PROPER HANDLING, 
GROUNDING AND PRECAUTIONARY ESD MEASURES ARE ESSENTIAL WHEN INSTALLING AND 
SERVICING PARTS OR MODULES.

NOTE:  This section describes how to install application modules and adapter modules. If 
your chassis came with modules already installed, skip this section and go to Local 
Management - Logging in to the FLEXmaster on page 29.

Each module is made up of an 
engine, or application module, and 
an adapter module.

Application Module
or Engine

Adapter Module
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Removing Adapter Strips
Engine and adapter modules may have ESD adapter strips attached when shipped. These adapter 
strips are required for 8-slot chassis installation, but must be removed for 2-slot chassis installation. 
To remove the adapter strips, loosen the screws holding the strips and slide the strips off the 
modules. Re-tighten the screws. 

Bottom - 
fixed knob

Top of Module - 
ejector handle

Slide to remove

ESD Adapter Strip
on Adapter Module
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Application Module Installation
When installing two modules in a 2-slot chassis, install the first in slot 1 (first slot from the 
left). 
When only using one module, install it in slot 2. This is to ensure optimal cooling 
performance. 

To install an application module: 
1. Gently slide the module into the slot and press firmly 

to make full contact with the midplane connector of 
the chassis. 

2. Be sure that the ID tag on the engine is to the right 
when inserting into the chassis. The text along the 
edge (2 SLOT DOWN) should be upright. 

3. Secure the application module to the chassis with the 
screws on the faceplate of the application module. 
When correctly installed, the application module 
faceplate will make contact with the chassis.

4. To install a second application module, repeat the 
process for slot 2.

Removing an Application Module
To remove an application module from a 2-slot chassis, remove the two screws that lock the 
module faceplate to the chassis, then push the ejector handle to the right to disengage the 
connectors. Slide the module out carefully. 

Adapter Installation
1. Insert the adapter module into the back of the 2-slot chassis (directly behind the application 

module installed in steps above) and press firmly to make full contact with the midplane 
connector of the chassis. 
Note: The text along the edge “2 SLOT DOWN” should be upright. 

2. Secure the adapter module to the chassis, by tightening the screws on the faceplate.

NOTE:  Empty slots should always be covered with faceplate covers (front and back) to be in 
compliance with product emission standards.
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Ethernet Switch Cabling
If you attach cables to the Ethernet switch ports at the front of the FLEXmaster16 module, you must 
install ferrite beads (part number 010-0051) on the cables to meet emissions requirements. Ferrite bead 
guidelines are as follows:

Up to four Ethernet cables can be grouped together within two ferrite beads.
The NMS cable can be grouped with Ethernet cables (up to the limit of four cables within two 
ferrite beads).
If the installation is limited to the backhaul Ethernet and/or the NMS cable, a single ferrite bead 
with a loop can be used. Note: The ferrite bead should be 4 to 5 inches from the connectors.

Example: If all of the Ethernet ports and the NMS port are cabled, four ferrite beads are required for 
the seven cables, as shown below.
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8-Slot Chassis Installation
The 8-slot chassis has eight application module slots and two power supply slots for redundant power. 
Dimensions: 

5.2 in. (H) x 10.2 in. (D) x 19 in. (W) 
Maximum depth of the shelf, including cables, is 12 inches

NOTE:  Blank faceplates must be installed on each open slot to be in compliance with product 
emission standards.

Supported Configurations
The following table indicates the configurations supported by the 8-slot chassis. 

For information about configurations supported by the 2-slot chassis, see 2-Slot Chassis Installation on 
page 7.

FM16 
TDM

FM16 
ATM

FM16 
PWE

Total Number 
of Modules

1 1*
1 1*

1 1*

1 2 3 4 5 6 7 8Slots:

Application Module
Slots

Power Supply
Slots

12
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Rack Mount Installation
Mounting brackets for a 19-inch rack are installed on the chassis when shipped. If you want to install 
the chassis in a 23-inch rack, you must purchase 23-inch mounting brackets from Turin Networks.

1. To install the unit in a 19-inch rack, attach the unit with the brackets to the rack using the screws 
provided. 

2. To install the unit in a 23-inch rack, remove the 19-inch mounting brackets and replace them 
with 23-inch mounting brackets purchased from Turin Networks.

3. Ground the unit.
a. Connect ground wire (16 - 18 gauge) from the ground terminal to earth ground.
b. Connect the chassis ground screw to earth ground.

The chassis ground screw is the raised green screw on the side of the chassis. When 
mid-mounting the chassis, you can replace this screw with a flat-head screw, if needed.

WARNING!   THE GROUND TERMINAL ON THE POWER BLOCK MUST BE CONNECTED TO 
EARTH GROUND TO PREVENT POSSIBLE DAMAGE TO THE EQUIPMENT. THE CHASSIS GROUND SCREW 
MUST ALSO BE CONNECTED TO THE EARTH GROUND

Mounting Bracket for a 19 inch rack Mounting Bracket for 23 inch rack

red black green

+   -

black

+   -

 Ground Terminal

 Chassis Ground Screw
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Power
The 8-slot chassis is available as a DC powered unit. The wide-ranging DC power 
supply is used for both -48 and +24 VDC applications. All power supplies are 
redundant and load sharing.

LEDs
The LED states of both power supplies. 

Power Supply Installation
To install the first power supply:

1. Remove the blank faceplate from power supply in slot 1.
2. Slide the first power supply into the empty power supply slot.
3. Press firmly to make full contact with the connector in the back of the chassis.
4. Tighten the screws found on the front of the power supply.
5. Install a second power supply (for redundancy) into power supply slot 2, as in steps 1-4. 

DC Power
The power entry modules provide DC power 
protection and isolation.

Each input has its own return.
The recommended wire gauge for 
connecting power is 16 to 18 gauge.

NOTE:  When using two power supplies, the input power must be connected to both A and B 
feeds. If you only power the A feed and are using two power supplies, you will need to jumper 
between input A and input B and also between return A and return B. Make this jumper the 
same gauge as the feed.

DC Configurations Power Supply 
Wattage

Input Power Feed(s) Fuse

±20 to 60 VDC 75W Dual 5A, 250 V

LED State Description
Power Off DC input missing or failure

Green DC input present

-

24/48 VDC
75 W

POWER

+24/-48 DC Power Supply 
DC Line Input 

Power Entry 

Alarm Contacts

Panel

Fuses
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Terminal Block
Attach the leads to the appropriate terminal using the securing 
screws on the block to tighten them.
The power terminal block and the alarm terminal block can be 
removed for easier lead attachment. Pry off the block with a 
screwdriver and remove it.

Dual Power Feed - Dual Power 
Supplies
Attach the leads to the appropriate terminal as 
indicated in the following diagram. Secure the 
leads with screws on the terminal block to 
tighten them.

Single Power Feed - Dual Power 
Supplies
Attach the leads to the appropriate terminal as 
indicated in the following diagram. Secure the 
leads with screws on the terminal block to tighten 
them.

WARNING!   THE TERMINAL ON THE POWER BLOCK MUST BE CONNECTED TO THE EARTH 
GROUND TO PREVENT POSSIBLE DAMAGE TO THE EQUIPMENT. 

Connect 16-18

Wire Securing Screws

Gauge Wire Here

Earth
Ground

RTN A
Return A

-48VDC

+24VDC
or

-48VDC

+24VDC
or

IN A
Power Entry A

IN B
Power Entry B

red redblack green

+   -

blackred black

+   -

RTN B
Return B

Earth
Ground

RTN A
Return A

-48VDC

+24VDC
or DC Power

Jumpers

IN A
Power Entry A

IN B
Power Entry B

redblack green

+   -

blackred black

+   -

RTN B
Return B

black
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Alarm Terminal Block 
The following table describes the alarm contacts on the DC powered 
chassis.

Alarm Contact
If you use the alarm contact feature, install a ferrite bead (part 
number 010-0051) with a loop.

Applying Power 

DANGER!   POSSIBLE SHOCK HAZARD EXISTS - FOLLOW INSTRUCTIONS 
CAREFULLY.

Wire Feed A and Feed B to a power source:
1. Ensure that no power is present on the two wires to be connected.
2. Remove the terminal block from the power entry panel.
3. Strip the two wires from the power source so that approximately 5/16 inch of bare wire is 

exposed. 16 or 18 AWG insulated copper wire is recommended for power connections.
4. Insert the wires (from the power source) into the appropriate square holes, one at a time.
5. Tighten screws to clamp wires.
6. Ensure that no bare wire shows after the wires are installed.
7. Plug the terminal block into the power entry panel. 
8. Apply power to the chassis.
9. A green light should appear on the power LED on the front of the power supply.

Contact Alarm Description
Major Alarm N.C. 

COM
N.O. 

Normally Closed
Common
Normally Open

Minor Alarm N.C. 
COM
N.O. 

Normally Closed
Common
Normally Open
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Modules

NOTE:  This section describes how to install application modules and adapter modules. If 
your chassis came with modules already installed, skip this section and go to Local 
Management - Logging in to the FLEXmaster on page 29.

Each module is made up of an engine 
or application module, and an adapter 
module.

WARNING!   STATIC PROTECTION IS REQUIRED DURING INSTALLATION. PROPER HANDLING, 
GROUNDING AND PRECAUTIONARY ESD MEASURES ARE ESSENTIAL WHEN INSTALLING AND 
SERVICING PARTS OR MODULES. 

Adapter Strip Installation
To be compliant with EMI, an adapter strip must be installed on the engine and adapter modules in 
an 8-slot chassis. Typically, adapter strips are shipped attached to the engine and adapter modules. 
If not, perform the following procedures to install the adapter strips.

Application Module
or Engine

Adapter Module
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Adapter Strip Installation on Engine
1. Slide the adapter strip under the screw heads until snug, as shown in the following figure. 

Spacers below the screw heads allow enough space to install the adapter strip without 
loosening the screws. (If the screws have been driven tight to the panel, loosen them enough 
to allow the slotted end of the adapter strip to fit under the screw heads.)

2. Tighten the screws to hold the adapter strip in place.

Adapter Strip Installation on Adapter Module
1. Slide the adapter strip under the screw heads until snug. Spacers below the screw heads 

allow enough space to install the adapter strip without loosening the screws. (If the screws 
have been driven tight to the panel, loosen them enough to allow the slotted end of the 
adapter strip to fit under the screw heads.)

2. Tighten the screws to hold the adapter strip in place.

Bottom - 
fixed knob

Top of Module- 
ejector handle

Slide until snug

ESD Adapter Strip
on Adapter Module
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Application Module Installation
FLEXmaster modules use more power than series 3 modules. As a result, you must install them in 
alternating slots.  NOTE: Multiple modules are not supported in this release.

Do not install an engine in slot 8 next to the power supplies. 

When installing the first module into the chassis, it is 
recommended to install it into slot 1 (first slot from the left). 
1. Gently slide the application module into slot 1 and press 

firmly to make full contact with the midplane connector of 
the chassis.
Master Module - The master module configures the rest of 
the modules (slaves). When installing modules into the 
8-slot chassis, insert a module, and when this module has 
completed its initialization (link LEDs show 
active - green), then install additional modules, if needed.

Install modules in alternating slots

8-slot Chassis

Insert Application 
Module here

Master Slot
Slot #1

Master Slot
Slot #1
Insert Adapter 
Module here
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2. Secure the application module to the chassis, with the screws 
on the faceplate of the module. When correctly installed, the 
application module faceplate will make contact with the 
chassis.

3. To install additional modules, repeat the process above for 
the remaining slots.

Removing an Application Module - To remove an application module from an 8-slot chassis, 
remove the two screws that lock the module faceplate to the 8-slot chassis, then lift up on the ejector 
handle (labeled with the module name) to disengage the connectors. Slide the module out carefully.

Adapter Module Installation
1. Insert the adapter module into the back of the 8-slot 

chassis (directly behind the application module 
installed using the application module installation 
procedure) and press firmly to make full contact with 
the midplane connector of the chassis. 

2. Secure the adapter module to the chassis, using the 
screws on the faceplate.

Screws
Retaining
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Local Management - Logging in to the FLEXmaster
The following sections describe how to log in to the FLEXmaster’s command line interface (CLI).

Connection Requirements
Connecting to the FLEXmaster’s NMS Port
Logging In

Connection Requirements
To use the FLEXmaster’s CLI, you must have the following items:

Laptop
VT100 terminal emulation software (such as HyperTerminal) on your laptop
Network Management cable (NMS cable) - MASTERseries network management cable, part 
number 80001/NM
Ferrite bead (part number 010-0051) for NMS cable
USB-to-serial adapter (if your laptop does not have a DB9 RS-232 port). Refer to PTN-06-0011 
for more information.

Ferrite Bead (2-Slot Chassis)
For the 2-slot chassis, a ferrite bead (part number 010-0051) is required for the NMS cable. Under 
certain circumstances, the NMS cable can be included in ferrites with the Ethernet switch cable(s). 
See Ethernet Switch Cabling on page 19 for instructions.

Ferrite Bead (8-Slot Chassis)
For the 8-slot chassis, add a ferrite bead (part number 010-0051) to the NMS cable. Install the bead 
with a single loop.

Installing the Bead:
1. Open ferrite bead with the depressions facing up. 
2. Wrap the NMS cable around the ferrite bead. Note: The ferrite bead 

should be 4 to 5 inches from the connector (RJ-45)
3. Make sure that two (2) turns are inside of the ferrite bead.
4. Snap the ferrite bead shut.

NOTE:  The following instructions assume you are using a laptop. You can also use a PC or 
VT 100 terminal.
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Connecting to the FLEXmaster’s NMS Port 

To connect to the FLEXmaster’s management (NMS) port:
1. Insert the network management cable into the NMS port on the front of the 

module.
2. Plug the other end of the NMS cable into the serial port on your laptop.
3. Launch your terminal emulation program and set the following port 

parameters:
Bits per Second: 9600
Data bits: 8
Parity: None
Stop Bits: 1
Flow Control: None

4. Make sure that the emulation is set to VT100 in your terminal emulation 
program.

HyperTerminal Users
Turin Networks recommends modifying HyperTerminal settings as described below. 
1. From within the HyperTerminal application, select 

File > Properties from the menu bar.
2. Select the Settings tab.
3. Click the ASCII Setup button.
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4. Set the Line delay to 50 milliseconds and the 
Character delay to 5 milliseconds.

5. Click OK.

Procomm Users
If you are unsure of the baud rate set on a module, connect to that module at 19200 baud and press 
the R key. If there is no response, use 9600 baud using the same approach. If there is a baud rate 
mismatch between Procomm and the master module, the master module could reboot. To prevent 
this: 
1. Go to Options> Data Options > Setup Files...
2. Select the Data tab.
3. Select Terminal Options. 
4. Set the Enquiry Type field to OFF. 
Other versions of Procomm might require you to navigate to the Enquiry Type field differently. 
Consult your Procomm manual for more information.

Additional Settings
Hardware flow control: Off

XON/XOFF flow control: Off

Use DTR (for hang-up): Off

Monitor DCD (carrier): Off

Exit on hang-up: Off
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Logging In
After connecting with your VT Terminal Emulation software, press ENTER, and the Login prompt 
appears.

Default Login: admin
Default Password: networknm 

When you log in to the FLEXmaster, you start in the root mode of the command line interface (CLI).  
At this point you can issue commands through the CLI.
Note:  You may see one of the following messages immediately upon logging in:

Unable to open userid file

Problem reading userid file

The admin user can still log in. You can correct this situation by adding, modifying, or deleting users. 
For information about these commands, see the adduser, moduser and deluser commands in the 
MASTERseries User Manual.
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Connectors

Engine (Front)
10/100Base-T Ethernet  (RJ-45)
The 10/100Base-T Ethernet (female) port to connect to a remote management 
tool such as Telnet or an SNMP-based Network Management System. The 
pinouts are as follows:

NMS Port
The Network Management Systems (NMS) craft port is a RJ-45 connector, 
with the following pinouts:

NOTE:  A ferrite bead is required on this cable, see Ferrite Bead on page 15 for further 
information.

Pin Name Description 
1 Receive + Receive from network
2 Receive - Receive from network
3 Transmit + Transmit to network
4-5 N/C Not connected 
6 Transmit - Transmit to network
7 - 8 N/C Not connected 

Pin Name Description 
1 N/C Not connected 
2 Tx Data Transmit Data
3 Rx Data Receive Data
4 N/C Not connected 
5 Ground/Drain Ground
6 N/C Not connected 
7 DSR Data Set Ready
8 DTR Data Terminal Ready

1 8

1 8
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Adapter (Back)
RS-232 (Subminiature DB-26 Connector)

Turin Networks makes a V.35 female to DB-26 male cable which can be used with the 
FLEXmaster16. 

T1/E1 Connection Ports (RJ-48C)
The rear adapter supports 16 T1/E1 link interfaces on the FLEXmaster16. 
The pinouts are as follows:

Pin Description Pin Description
1 Shield (Prot. Ground) 14 Transmit Data B
2 Transmit Data A 15 Receive Clock A
3 Receive Data A 16 Receive Data B
4 RTS 17 Receive Clock B
5 CTS 18 Open Pins/No Contact
6 DSR 19 Open Pins/No Contact
7 Signal Ground 20 DTR
8 CD (RLSD) 21 Open Pins/No Contact
9 Open Pins/No Contact 22 N/C Not Connected
10 Xmit Clock A 23 Xmit Clock B
11 External Clock A 24 External Clock B
12 N/C Not Connected 25 N/C Not Connected
13 Open Pins/No Contact 26 Open Pins/No Contact

Part Number Length
005-0014 10 feet
005-0068-0100 25ft
005-0069-0100 50ft

Pin Description
1 Receive Ring
2 Receive Tip
3 N/C
4 Transmit Ring
5 Transmit Tip
6 - 7 N/C
8 Chassis Ground

1

13

14

26

1 8
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LEDs
The LEDs on the FLEXmaster16 application module are 
described below. 

Ethernet LEDs

Module Status LEDs

LED State Description
Activity
(Top in 8-slot; 
Right in 2-slot)

Off No activity.
Blinking Yellow 
or
Blinking Green

Activity on circuit.
(Connector may have a yellow or green 
LED at this position.)

Status
(Bottom in 8-slot; 
Left in 2-slot)

Off No connection to port.
Solid Green Port connected to a valid source. 

LED State Description
PST Flashing Green Passed power system test.

Master module. 
Off Slave module.

ALM Solid Red Alarm on a T1/E1 port, or failed power system 
test.

Off No alarm.

Module
Status

Link 
Status

Ethernet 
Status
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T1/E1 Link LEDs
LED State Description
FM16  1-16 Solid Red OOF - Out of Frame or AIS.

Solid Green Normal, link is up.
Flashing Red LOS - Loss of Signal.
Solid Yellow Yellow sync alarm or RAI. Indicates red alarm 

on the far end.
Flashing - 
alternating Yellow 
and Green

Loopback in progress. 

Off Link is disabled.
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